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Introduction

AND Route 98 for Maximizer is an up-to-date route planner for road users.
Powerful yet easy to use, it is perfect for planning all leisure and business
journeys by road - accurately, quickly and intuitively.

Please note that you have been provided a free feature-reduced version
with your purchase of Maximizer.  The functionality described in this
manual is based on the full working version.  If you wish to upgrade for
enjoying the full benefits of AND Route 98 for Maximizer please go to: 
http://www.andusa.com or call us at 1-800-848-0822.

Easy to Use

Simply type the first few letters of the place name or ZIP Code to enter your
start, via and destination locations, and AND Route 98 for Maximizer will
calculate your optimum route.  An intuitive layout with clear buttons, detailed
route description and map makes AND Route 98 for Maximizer a no-fuss
travel planner.

Fast

In just seconds, AND Route 98 for Maximizer clearly displays the fastest
optimum route, (with alternatives where applicable), on screen and in full
color.  You can print both the route description and the map to take with you
on your journey.

Up-to-date

The road networks used in AND Route 98 for Maximizer products are
continually updated by AND Mapping, one of the world’s foremost suppliers of
digital road information to commerce and industry. AND Mapping is an ISO-
9002 certified organization.  ISO-9002 certification is awarded for tested and
proven ongoing technical excellence in data and procedure accuracy and
reliability.

Other features include:

• A Via facility so you can plan multi-destination journeys and avoid certain
destinations and roads

• Depending on the road network purchased, AND Route 98 for Maximizer
may allow you to select specific types of location, such as railway stations,
airports, and national border crossings

• AND Route 98 for Maximizer has a Windows 95 e-mail link so you can
send a map and directions to business contacts and friends easily



Detailed information
The route information consists of the names, or numbers, of the roads, the
crossings and exit ramps along the route with their numbers, the length of the
route in miles, the distance between various places and exit ramps, and the
approximate duration of the journey.  AND Route 98 for Maximizer also allows
you to determine the amount of detail in which this information is presented.

The optimum route is graphically displayed on a map, with any alternative
routes also highlighted.  The map offers a variety of other interesting features:
in addition to providing you with insight into the geographical course of the
journey, arrival and departure points can be selected straight off the map, as
well as other nearby locations.  The application also allows you to zoom in on
the map in order to obtain more detail, or to zoom out to obtain a better
overview.

Additional information about AND Route 98 for Maximizer, where applicable,
can be found in the 'andnotes' file on the CD-ROM.



Preface

AND Route 98 for Maximizer - Windows version

© AND Publishing Technology B.V. Rotterdam 1998
© AND Mapping B.V., Rotterdam 1998 (digital mapping data)
All rights reserved, AND Publishing Technology B.V. No part of this
publication may be copied, stored in a database*, changed or publicized, in
any way or form whatsoever, without the prior written permission of AND
Technology Ltd.

The purchaser of this product is granted a non-exclusive single user license
for use of the software on one PC.

All liability for loss, disappointment, negligence or other damage caused by
reliance on the information contained in AND Route 98 for Maximizer, or use
of the software is hereby excluded.

* With the exception of data needed to run the application and calculate
routes

Methodology used to calculate route information

AND Route 98 for Maximizer contains information on the type of road making
up each road segment, e.g. Interstate Highway, as well as information on the
average speed of traffic traveling on these segments.  Each type of road is
also associated with a given priority based on the desirability of traveling on
the type of road involved.  When determining the quickest route, the
application takes the priority associated with the various roads into account,
as well as the average speed on the various types of roads.  The average
speeds and priorities associated with the various roads cannot be changed.

The average speeds used within the program are:

• Interstate Highways: 63 mph (in town: 37 mph)
• Four-lane Highways: 43.5 mph (in town: 25 mph)
• Major Highways: 38 mph (in town: 22 mph)
• Regional Roads: 31 mph (in town: 19 mph)
• Local Roads: 25 mph (in town: 16 mph)
• Other roads: 19 mph (in town: 13 mph)

Up-to-date information
The road networks used in AND Route 98 for Maximizer are continually
updated by AND Mapping, one of the world’s foremost suppliers of digital road
information to commerce and industry. AND Mapping is an ISO-9002 certified
organization.



Help desk

Free Lifetime Support for Registered Users
In the event of problems with the use of AND Route 98 for Maximizer, please
go to http://maximizer.andusa.com/help.  Here you will find answers to the
most commonly asked questions.  Alternatively you can send us a fax.

Before faxing the Help desk, make sure that you include the following
information in your request:
• Your computer's brand name and type
• The type of monitor (video card) you are using
• The amount of free working memory (this can be checked with the help of

'About AND Route 98 for Maximizer' in the Help menu)
• The Windows version you are using
• A clear description of the problem you encountered
The Help desk can be reached at the following fax number: (410) 659-1288



Network and commercial licenses

Please contact AND USA Inc., at (410) 659-0228 for network licenses and
commercial licenses.  Note: Support requests cannot be handled at this
number.
Network licenses and commercial licenses can also be ordered by fax on
(410) 659-1288



Conventions

AND Route 98 for Maximizer commands can be executed using Alt-<letter>
key combinations.  The letter to be used for each of the commands is always
underlined in the application.  Alt-F, for example, takes you to the File menu of
the Menu bar.  A number of commands can also be carried out using quick
keys, such as opening files (Ctrl + O), or printing information (Ctrl + P).  The
quick keys are displayed in the various menus after the corresponding menu
commands.
System keys such as the Tab key and the Enter key are displayed between
angular brackets in this manual.  Whenever you see either <Tab> or <Enter>
in the instructions in this manual, press the appropriate key to carry out the
command in question.  Text that must be typed-in is displayed in bold print.



Minimum system requirements

In order to use AND Route 98 for Maximizer, you must have:
• an IBM-compatible computer with an 80486 processor or higher
• a CD-ROM drive
• Windows 95
• 16 MB RAM internal memory
• a hard disk with a minimum of 2.5 MB free
• a VGA video card or better and a color monitor
• Optional: a printer



Starting and closing of AND Route 98 for Maximizer

Start AND Route 98 for Maximizer by double-clicking the AND Route 98 for
Maximizer icon in the Windows Program manager (Win 3.1) or in the AND
Travel Series folder in the Start Menu (Win 95).

Close AND Route 98 for Maximizer by selecting 'Close' in the File menu



The Main window of AND Route 98 for Maximizer

The Title bar contains the name of the application, 'AND Route 98 for
Maximizer ', and the road network which is currently active.

The Menu bar contains various menus containing all of the AND Route 98 for
Maximizer commands and options.  Descriptions of the menu commands can
be displayed on the Status line, (see Status line), by placing the mouse cursor
on the command desired.  A complete overview of AND Route 98 for
Maximizer functions is provided in the section 'The Menu bar'.

The Input fields for the departure and arrival points can be found under the
Menu bar, along with the Work bars containing most of the Menu bar
functions.  A single click activates the underlying functions.  Work bar buttons
that can not be selected are displayed in grey.
A small pop-up window containing explanatory information will also appear
whenever you place the mouse cursor on any Work bar button.  The Work bar
buttons are explained in the description of the corresponding functions (see
'The Menu bar').  There are four Work bars: Route, Map, Export, and Settings.

In addition to the Input fields and the Work bars, the File Library, containing
the road networks you have purchased, is also found under the Menu bar.
Each file is identified by its own clearly recognizable icon.  If you are using the
North America version of AND Route 98 for Maximizer for the first time, start
the application with the U.S. road network.  Start the European version of
AND Route 98 for Maximizer for the first time with the European road network.
The next time you start AND Route 98 for Maximizer, the most recently used
road network will appear automatically.

Most of the default Main window is given to the Route overview displaying
journey instructions.  The remainder of the Main window displays the Map of
your selected road network.

The routes in the Route overview each have their own Tab sheet, i.e. the
optimal route and any alternatives. The alternative routes can be displayed by
clicking the appropriate Tab sheet. You determine the amount of detail
displayed in the information in the Route overview yourself, by selecting a
specific detail level.  For more information see Route overview

The map will display your chosen departure and arrival points and the
calculated routes. The Map graphically displays the calculated route from the
departure point to the arrival point.
The optimal route is represented by a thick black line, the first alternative
route by a thick grey line and the second alternative route by a thick brown
line.  The departure location is flagged by a blue pushpin, the arrival location
by a bright green pushpin.  Via locations are flagged by a dark green pushpin.

The Status line, which actually consists of two components, is displayed at
the very bottom of the Main window.  The left-hand side of the Status line



displays an explanation of the menu command or button on which the cursor
is placed.  The right-hand side of the Status line displays the selected
departure and arrival points, the total distance between those points, and the
approximate travel duration of the selected route.  This information changes
as alternative routes are selected or new routes are calculated. Between the
departure and arrival point you will find the button .  By clicking this button,
a special dialogue window will appear in which you can select and add Vias
along the route.  This dialogue window can also be opened by selecting the
command 'Selecting Vias along the route' in the Route menu.

The layout of the Main window described above is the standard layout.  The
appearance of the Main window can be changed to meet your individual
requirements.  The individual Work bars and the File Library, for example,
which are found under the Menu bar in the standard window layout, can be
placed directly in the Main window.  The Route overview can also be moved,
or even adjusted in size.  Note: moving elements in the Main window is
practical only if your monitor is larger then 14 inches. If your monitor is 14
inches or smaller, you will probably want to streamline the Main window by
concealing certain elements Adjusting the layout of the Main window



Extensive instruction

As with all Windows programs, any functions within AND Route 98 for
Maximizer can be executed in a variety of ways: via the Menu bar, via an icon
on one of the Work bars and via the right-hand mouse button. The right-hand
mouse button can be used only in the Map or in the Route overview. Clicking
this button will cause a number of options, relevant to your current cursor
location within the application, to appear.

Selecting a file
Selecting departure and arrival points
Selecting from a list containing specific types of locations
Selecting from a list of all types of locations
Selecting Via's along the route
Calculating routes
The Route overview
The Map
Example



Selecting a file

When using AND Route 98 for Maximizer for the first time, it will open with the
individual road network that you have just purchased and installed.  Any
subsequent sessions will, if you have purchased and installed more than one
network, open with the road network that was previously used.

When you have two or more AND Route 98 for Maximizer products, selection
of a different road network can be achieved in a variety of ways:

(1) Via the File menu:
a) Select 'Open' in the File menu.  A dialogue window in which the appropriate
file can be selected will appear.  The file selected will be opened immediately
and the appropriate icon will be placed in the File library.
or
b) Select the desired file from the File list in the File menu.

(2) Via the File library: Click the icon of the file desired in the File library.

(3) Via the Open file icon : Clicking this icon will cause the Open file
dialogue window to appear.  Select the desired file in this window.  Click 'OK'
to open the file and have the icon placed in the File library.

Note: Only one road network at a time can be activated in AND Route 98 for
Maximizer.



Selecting departure and arrival points

Prior to selecting departure and arrival points, you may, depending on the
AND Route 98 for Maximizer network purchased, have the option to limit the
number of locations to specific choices such as railway stations, airports or
border crossings.

See the following topics for further information:
Selecting from a list containing specific types of locations
Selecting from a list of all types of locations



Selecting from a list containing specific types of
locations

Use the Find locations dialogue window to limit the locations displayed for
selection to a specific type of location.  This window can be activated as
follows:

• select 'Find locations...' in the menu under the right-hand mouse button in
the Map or the Route overview

• click the Find locations icon 
• select 'Find locations...' in the Edit menu

The Find locations dialogue window will appear. Select from the Restriction
lists on the right-hand side.  These lists will normally display the words 'No
restrictions'.
If, for example, you wish to select a railway station as departure location, and
you wish to display the entire list of possible locations from which to select an
arrival point, you would:

1. Open the top 'Restrict To' list by clicking the arrow. You may then be
offered a choice of subgroups including:

• no restrictions
• railway stations
• border crossings
• airports

2. Click 'railway stations'.

3. Open the list of departure locations.  Only locations that are railway
stations are displayed.

4. Select the station desired.

5. Type the arrival location directly into the Main Window Input field or
select it from the list of arrival locations.

6. Click 'Calculate' to have the route calculated.  Click 'Close' if you wish to
quit the window without having the route calculated.

The selected locations appear automatically in the Input fields in the Main
window.



Selecting from a list of all types of locations

Selection of departure and arrival points from a list of all types of locations can
be carried out in a variety of ways.

You can use the Input fields, which are located under the Menu bar.  Even if
you do choose to use another selection method, your departure and arrival
points will be displayed in these Input fields.  The methods differ only in that
you may place the locations in the Input fields directly or indirectly.  The
various methods are described below.

The Input fields
The following method can be used to select locations directly via the Input
fields:
Type the location in the Input field and confirm your selection with <Enter> or
select the location from the drop-down list.  The list can be opened by clicking
the arrow next to the Input field or by pressing <'Down' arrow>.  These two
methods can also be combined, which is particularly useful if you are not sure
of the exact spelling of a given location.  Type the first few letters of the
location name in the Input field and then open the list.  All of the locations
beginning with the letters you have entered will be displayed.  The list
automatically appears per character while entering a new location.

In addition to entering city and town names as locations, you may also be able
to enter ZIP Codes, railway stations, border crossings, etc.  Before entering
something other than a city as the location desired, check the notation
conventions for the type of location you wish to enter.

Other location Input methods
Selecting locations
Locations can be selected in the Map using the following method:

• Position the mouse cursor at the approximate geographic position of the
desired location on the Map

• Press <Shift> and click the left mouse button.  The locations in the nearby
vicinity of the mouse cursor will now appear in a list.  Note: this may take
some time on relatively slow computers and this method works only if your
cursor is positioned above land

• Select your location from those displayed

You can also select a location from the Route overview.  Place the mouse
cursor on the desired location in the Route overview and click, or use the
cursor keys to move to the desired location.

Transforming the selected location into a departure or arrival point
Once you have selected a location, the location must be transformed into a
departure point or arrival point so that it appears in one of the Input fields.



This is accomplished as follows:

• Select '<selected location> as departure' or '<selected location> as arrival'
in the menu under the right-hand mouse button, (while the cursor is over
the Map or Route overview).

or
• Select the command 'selected location as departure' or 'selected location

as arrival' in the Route menu.

The chosen location will now appear in one of the Input fields.



Selecting Via's along the route

Once you have entered your departure and final destination points in the Input
fields, you may wish to customize your journey by adding a number of Via
locations.  AND Route 98 for Maximizer will then calculate the optimal route,
(with possible alternative routes), and include these additional locations in
your journey plan. You can select a 'Via' location in a number of ways:

• Choose 'Vias along the route add/delete' in the menu under the right
mouse button in the Map or the Route overview

or

• click on 
or
• click on 
or
• choose the command 'Select Vias along the route' in the Route menu.

The Select Vias along-the-route-dialogue window will appear now.  Open the
list of locations by clicking the arrow.  Select the desired intermediate location
from the list and click 'Add' to include this location in the present route.
Repeat this for every intermediate location you want to visit on your way.  A
location can always be deleted by highlighting it and clicking 'Delete'.

Select 'Calculate' to continue or 'Close' if you want to leave the dialogue.

New 'Via' locations will always appear below whatever current route location
entry is highlighted.  To enter 'Via' locations in a particular sequence, simply
change the highlighted entry.



Calculating routes

A variety of route calculation prompts are available:

If you used the Find locations dialogue window to select the desired locations,
you can proceed by clicking 'Calculate'.

If you used another method to select the desired locations, and those
locations are now displayed in the Input fields, you can calculate the route as
follows:

Select 'Calculate route' in the menu under the right-hand mouse button in the
Map or in the Route overview
or
click the corresponding icon 
or
select the command 'Calculate route' in the Route menu.



The Route overview

Once the route has been calculated, directions for the optimal route will
appear in the Route overview and the map will display all proposed routes
including possible alternatives.

The Route Overview consists of five columns.

First column: gives locations and displays points that you will pass during the
course of your journey
Second column: displays the numbers of the roads your route follows.
Third column: indicates the 'follow' direction
Fourth column: shows the cumulative distance in miles.
Fifth column: displays the cumulative time of your journey

The total travel time is displayed at the bottom of the route overview behind
arrival location.  The total distance and the expected travel time can be found
in the Status line beside the departure and arrival location.

Dependent on the actual journey, the Route overview allows you to view any
alternative routes that may be available (A maximum of two) by clicking on
additional Tab sheets.  These routes are the best alternatives to the optimal
route.  You can navigate through the Route overview with the help of either
the cursor keys or the Scroll bar.

AND Route 98 for Maximizer allows you, via four route information
presentation levels, to determine the amount of detail in which the route
directions are presented: level 1 provides you with the least detail, while level
4 provides you with the most detail.  In addition, AND Route 98 for Maximizer
also enables you to request additional detail, or limit the amount of detail
provided, for a specific section of the route. Each line of information displayed
in the Route overview represents a 'section' of the route.  There are a number
of ways in which to select the level of detail for the presentation of route
information - and to request additional detail, or less detail, for a specific
section of the route:

• Place the mouse cursor in the Route overview and left-click quickly twice
on a line of your choice

or
• highlight a line of your choice in the Route overview, press the right-hand

mouse button and select 'Fold section' or 'Unfold section'
or
• select the overall level required in the Route overview menu.



The Map

The Map graphically displays the calculated route from the departure point to
the arrival point.
The optimal route is represented by a thick black line, the first alternative
route by a thick grey line and the second alternative route by a thick brown
line.  The departure location is flagged by a blue pushpin, the arrival location
by a bright green pushpin.  Via locations are flagged by a dark green pushpin.

You can change the colors of the map and the roads in the display.  (See
Preferences)

In addition to the ability to select arrival and departure locations directly from
the map, it also allows you to zoom in and out at various levels, to request the
complete Map with a single command, (useful if you have zoomed in to a very
high level of detail), and to redisplay the route.  You can also highlight an area
to be enlarged by simply 'dragging' the cursor diagonally over the map while
depressing the left-hand mouse button.  You can undo this command simply
by pressing <Esc>.

There are also three other ways to zoom in for greater detail on the Map, or to
zoom out for a better overview:
• Select the desired zoom command in the menu under the right-hand

mouse button in the Map
or
• select the desired zoom command in the Map menu
or
• use the buttons on the Map work bar , , , .



Example

The way in which AND Route 98 for Maximizer works is best explained based
on an example.  Our example is based on use of the U.S. road network, which
allows us to enter ZIP Codes as locations.  Standard ZIP Codes consist of five
numbers, e.g. 21202 is a postal ZIP Code area in Baltimore, Maryland.
Let us assume that you wish to drive from Baltimore, ZIP Code area 21202, to
Oxford, Ohio.  These locations can be entered in a variety of different ways.
We will use the Input fields to select the departure and arrival points, and the
Route work bar to have the route calculated.

Do the following:
Go to the Input field for the departure location by clicking with the mouse or by
pressing <Tab> until you reach the desired Input field.  Type 21202 Baltimore
(MD) in this Input field.  Confirm your entry by pressing <Enter>.  The cursor
will now automatically jump to the Input field for the arrival point.  Type Oxford
(OH) in this field and press <Enter>.  You may also enter both locations by
making use of the drop-down list of locations (i.e. type '21202' and then select
‘21202 Baltimore (MD)’).
Go to the Route work bar and click the Calculate route icon .  The
application then calculates the route information.  The description of the
optimal route appears in the Route overview and the corresponding route
appears on the Map with the route directions displayed cumulatively.  In
addition, two alternative routes have been calculated, which are displayed if
you click the Tab sheet '1st Alternative' first and then '2nd Alternative'.

Both the optimal and the alternative route descriptions contain the following
information:
The departure location, '21202 Baltimore (MD)' appears at the top of the
description, while you can see the arrival location 'Oxford (OH)' at the end of
the description.  The crossings, exit ramps, etc., which you will come across
on your journey between '21202 Baltimore (MD)' and 'Oxford (OH)' are
displayed followed by the road designations of the route.  The application also
provides you with information on the length of each section of the route and
the approximate duration of the journey over each of those sections.
The Status line at the very bottom of the screen displays the departure and
arrival points, the total length of the route in miles and the total approximate
duration of the entire journey.



Special characteristics of AND Route 98 for Maximizer

AND Route 98 for Maximizer offer several other special features:

Adjusting the layout of the Main window
Cut, copy and paste
Printing
E-Mail
Preferences



Adjusting the layout of the Main window

The layout of the Main window can be changed very easily to meet your
individual needs.  You can determine, for example, whether or not you want
the following elements to appear on your screen as part of the Main window:

Route work bar
Route overview
File library
Map work bar
Export work bar
Settings work bar
Legends

Any number of the items mentioned above can be revealed, or concealed, in
the Main window by clicking the appropriate element or elements in the
Window menu.  This feature can be quite useful if you wish to streamline the
Main window.

You can also move elements within the Main window.  Normally, these
elements are located at 'fixed' points in the Main window, but they can also be
moved.  Note: the Map is the only element of the Main window which cannot
be moved and which cannot be concealed.
Elements can be moved as follows:

• Place the mouse cursor on the element you wish to move
• Press the left-hand mouse button.  The edge of the element you wish to

move will become vague
• Hold the mouse button and move the mouse in the direction you wish to

move the element.  As you move the mouse, the element will display a
vague, thick edge, which means that the element is disconnected from the
Main window

• Release the mouse button when you have reached the desired position in
the screen.  The element will be fixed into its new position in the Main
window.  If you have moved the element in such a way that part of it falls
outside of the screen, the application will automatically move it so that the
entire element is displayed

Moved elements tend to click themselves back onto the Main window rather
quickly.  This can be prevented by disconnecting the element from the Main
window, as described above, and then pressing <Ctrl>.  This will cause the
element to become a separate window instead of being connected to the main
window.

The Split bar between the Map and the Route overview can be moved to
create more space for either one.



You may return to the standard layout at any time simply by clicking 'Standard
window layout' in the Window menu, or by clicking the corresponding button
on the Route work bar.

Your customized Main window layout is automatically saved when you close
AND Route 98 for Maximizer.



Cut, copy and paste

The availability of the various options in the Edit menu is dependent on the
element of the application that you are using at that time.  If, for example, you
are in the Map or in the Route overview, only the 'Copy' command will be
available.  This command can then be used to copy the Map or the route
information displayed to the Clipboard.  The Map or the route information can
also be copied directly from the Map or the Route overview by selecting 'Copy
route description/map' in the menu under the right-hand mouse button.
If you are in an Input field, all edit commands can be used.  The command
'Cut selected text' removes any text from the Input field, 'Copy Map/Route
description/Selected text' copies the Map, Route description or selected text
to the Clipboard, and the command 'Paste text' places the contents of the
Clipboard in the Input field.  In the last case, whether or not the pasted text
can be used in AND Route 98 for Maximizer depends on whether the pasted
location actually appears in the list of locations.



Printing

In addition to allowing you to determine the level of detail of the information
printed, AND Route 98 for Maximizer also allows you to determine which
information you want printed; (see The Route overview for additional
information).  To determine the information to be printed, select the command
'Print' in the File menu or click the Print icon .  A dialogue window with two
Tab sheets will then appear – one for the items which you wish to print, and
one for the level of detail.  Click the Tab sheet you desire.  The 'Items' Tab
sheet can be used to print both the route information for one or more routes
and the Map.  When printing route information, you may select the route, or
routes, you wish to print, i.e.: one or a combination of optimal and alternative
routes.
The 'Level of detail' Tab sheet can be used to set the level of detail printed.
Closing the Tab sheet with 'OK' saves the settings of both Tab sheets.
Once you have closed the Tab sheets with 'OK', the Print dialogue window will
appear.



E-mail

The route information, the map, or both, can be mailed immediately by simply
choosing 'E-Mail' under the file menu, or by clicking the E-Mail icon .  The
dialogue window, which then appears, can be used for both mailing and
printing, (see the previous paragraph Printing for a complete description of
how this dialogue window works).  The text of the route descriptions is mailed
exactly as you see it on your screen.  Maps, however, are mailed as separate
.bmp files.

Note:  'E-Mail' works only if you run Windows 95 or Windows NT, and possess
a mail package.  If you do not possess a mail package, the E-Mail icon will be
displayed in grey.



Preferences

Settings can be changed by selecting the command Preferences in the File
menu, or by clicking the Preferences icon .  This relates to the following:

the level of Map detail:  Click the Tab sheet 'Map level of detail'.  You can
select any of five levels of detail.  If you select 'Automatic', the application will
select the level of detail which best corresponds to the scale selected.

the colors of the Map:  Click the Tab sheet 'Map Colors' to change the colors
in which land, cities, and water are presented.  Click 'Change' to select a new
color.   'Back' can be clicked at any time to undo your selection.

the appearance of the Roads AND Route 98 for Maximizer:  Click the Tab
sheet 'Road colors' to adapt the color and width of the different kinds of roads,
and the calculated routes.  First select the road or route which you want to
change by clicking the corresponding button.  On clicking 'Change Color', a
color dialogue window will appear in which you can select a new color.  After
clicking on 'Change Width', you can enter a new width in the adjacent input
box.  'Back' can be clicked at any time to undo your selection.

the print font:  Click the Tab sheet 'Print font' and select the font and font size
desired.  The selected settings will be used when printing route information.



File menu

Open or 
Opens a road network file and places it in the File library.

Print or 
Opens a dialogue window with two Tab sheets that can be used to select your
preferences for print and mail settings.  Once the Tab sheets have been
closed with 'OK', the Print dialogue window will appear, (see Printing for
additional information).

Print example
Opens a dialogue window with two Tab sheets that can be used to select your
preferences for print and mail settings.  Once the Tab sheets have been
closed with 'OK', the print example with the selected settings will appear on
your screen.

E-Mail or 
Opens a dialogue window with two Tab sheets that can be used to select your
preferences for print and mail settings.  Once the Tab sheets have been
closed with 'OK', the dialogue window of your mail software will appear, (see
Mail for additional information).

Preferences or 
Opens a dialogue window with four Tab sheets that can be used to change
settings used by AND Route 98 for Maximizer: the level of detail, the font and
font size used when printing, the colors of the roads and calculated routes,
and the map colors.  (See Preferencesfor additional information).

File list
AND Route 98 for Maximizer maintains a list of the files you opened most
recently (a maximum of eight), allowing you to easily open the files you are
likely to use most frequently.

Close
Closes AND Route 98 for Maximizer.



Edit menu

Cut selected text
Cuts text from the selected Input field.

Copy Map/Route description/Selected text
Copies the Map, the Route description or the selected text to the Clipboard.
The Main window element active at the moment this command is invoked,
(Map, Route overview or Input field), determines what is copied.

Paste text
Pastes text from the Clipboard into the selected Input field.  Whether or not
the pasted text can be used in AND Route 98 for Maximizer depends on
whether or not the location actually appears in the list of locations.

Find locations... or 
Opens the Find locations dialogue window.  This window is used if you wish to
see specific locations only – e.g. railway stations, border crossings, etc.  (See
also Selecting from a list containing specific locations.)



Route menu

Calculate Route or 
Calculates the optimal route, based on your selected departure and arrival
locations.

<Selected location> as departure or 
Makes the selected location the departure point for route calculation.

<Selected location> as arrival or 
Makes the selected location the arrival point for route calculation.

Selecting Via's along the route or 
Shows a dialogue window in which you can enter locations you want to visit
on your journey.  The program calculates the optimal route, (with possible
alternative routes), from departure to arrival points via these additional
locations.  (See also Selecting Via's along the route.)



Map menu

Zoom in or 
Zooms in on the center of the Map.  You can zoom in several times.

Zoom out or 
Zooms out from the center of the Map.  You can zoom out until the entire Map
becomes visible.

Entire map or 
Places the entire Map in the Main window with a single command.

Zoom to the route or 
Places the entire route in the Main window with a single command.



Route overview menu

Unfold to level 1
Displays the route information contained in the first, (least detailed), level.

Unfold to level 2
Displays the route information contained in the first and second, (more
detailed), levels.

Unfold to level 3
Displays the route information contained in the first, second and third
(relatively detailed) levels.

Unfold to level 4
Displays the route information contained in the first, second, third and fourth,
(most detailed), levels.

Unfold section
Displays more detailed route information for the section selected, i.e. the line
selected in the Route overview at the moment this command is invoked.

Fold section
Displays the standard route information for the section selected, i.e. the
information that is normally displayed in the Route overview after calculation
of the optimal route.



Window menu

Standard window layout or 
Returns the Main window to the standard layout.

The remaining commands in this menu enable you to reveal or conceal
certain elements of the Main window by simply clicking the element you wish
to reveal or conceal.  A check mark next to the element in the menu tells you
whether the element is visible or invisible.

The following elements can be revealed or concealed:

Route work bar
Route overview
File library
Map work bar
Export work bar
Settings work bar
Legends



Help menu

Contents or 
Gives you access to the AND Route 98 for Maximizer Help file.  The Help file
provides you with the necessary assistance in cases in which you do not have
ready access to this manual.  The command Contents provides you with a
section-by-section overview of the topics available in the Help file.

Search
Provides an alphabetical list of all of the topics available in the Help file.

Using Help
Provides a general introduction to the use of the Help file.

About AND Route 98 for Maximizer
Provides information on the version number of AND Route 98 for Maximizer
for Windows, information on copyrights, and information on your computer.



All buttons

Route Work bar

= Calculate route

 = Select Via location

 = Find locations

= Help

Map Work bar

= Zoom in

= Zoom out

= Entire map

= Zoom into the route

Export Work bar

= Print

= E-mail

Settings Work bar

= Open road network

= Standard Window layout

= Preferences


